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Conventions

PPA for DM Manual

The typographic conventions used in this manual are described below.

Convention

Bold

Menu...MenuOption

CAPS

Italics

Description

Used to denote specified elements of the user interface such as
buttons, field names, menus, and menu options.
For example, the New button.

Select the Menu from the Menu bar then select the Menu Option
from the Menu.

For example, File...Open would mean select the File Menu and
then the Open Option.

Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Used to denote emphasis, captions and the result of an action in a
procedure.
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Introduction to Peak Pairs Analysis (PPA)

PPA stands for Peak Pairs Analysis, the DigitalMicrograph plug-in for High-Resolution Peak
Measurement and Strain Mapping Analysis.

All results obtained by PPA are fully compatible with the other functions present in DM. For
example, strain maps can be analyzed and/or manipulated with functions such as histograms,
statistics (mean, standard deviation, min, max etc.), or using the corresponding buttons, such
as the Profile utility.

The main reference for the algorithm is:

The Peak Pairs algorithm for strain mapping from HRTEM images

Pedro L. Galindo, Stawomir Kret, Ana M. Sanchez, Jean-Yves Laval, Andrés Yafiez,
Joaquin Pizarro, Elisa Guerrero, Teresa Ben and Sergio 1. Molina

Ultramicroscopy 107 (2007) 1186—1193 (doi: 10.1016/j.ultramic.2007.01.019)

This manual will help you to use of the PPA package with some worked examples. There is
also a quick reference guide at the end of this document.

Software requirements

The following is a list of the software requirements necessary to run the PPA plug-in:

- DigitalMicrograph (Gatan™ )
- USB Key Driver
-  HREM Mouse Tool Plug-in (freeware downloadable from www.hremresearch.com)

- IPU Plug-in (freeware downloadable from www.hremresearch.com)
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Software Installation

Installing USB Key Driver

The user key driver should be installed by following the instructions given by the key driver
installer. You can find the key driver installer at the plug-in page on HREM Research web
site.

Installing DigitalMicrograph Plug-ins

The DigitalMicrograph Plug-in will be provided as Gatan compiled script file(s) (.gtk) and
dynamic link library file(s) (.dll). All these files can be installed by copy-and-paste to the
folder “Pluglns.” (The Pluglns folder should exist under a normal installation of the
DigitalMicrograph).

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, the
Pluglns will appear as a new menu or an addition to the standard tools.

Installing Mouse Tools i D £ R {Iﬁ; )

All the files relating Mouse tool plug-in can be installed
by copy-and-paste to the folder “Pluglns.” The Mouse
tool will appear as an addition to the standard tools.

Installing IPU Plug-in

The PPA plug-in uses some functions based on the Intel” MKL (Math Kernel Library)
provided by the IPU plug-in. All the files relating the IPU plug-in can be installed by copy-
and-paste copy. The IPU plug-in will appear as under /PU menu. Please consult the ReadMe
file that comes with the IPU plug-in.

Installing PPA PeakPairs [ )
Fourier Space Noise Filter »
PeakPairs.gtk and PeakPairs.dll can be installed by drag- e ele el G '
and-copy to the folder “Pluglns” (The Pluglns folder S G EEeiE
should exist under a normal installation of the Motif Detection »
DigitalMicrograph.) Find Peaks »
Find Peak Pairs
When the DigitalMicrograph is launched after placing the Displacement Maps
plug-ins into the Plugins folder, PeakPairs menu Define Reference
commands will appear. Correct Scan Line Noise...
Strain Map...

Repeat Project...
Project 4

Image Group »

Analyze Peak Points

Analyze Equivalent Columns...
Distortion Analysis >
Histogram from Spreadsheet
Show/Hide »
Add Color Marker

Create Vector Map...

Distortion Correction »

Help »
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Getting Started

Image pre-processing and Basis Vector Selection
(Bragg Filter)

Open the file QuantumWire.dm3 using the DM command File...Open:

=

i F: QuantumWire

This image represents a
capped InAs quantum
wire on GaAs.
Composition was consi-
dered to be uniform
inside the quantum wire
and across the wetting
DOOLARARE layer.

R A AR

O .
R RAN

All the commands related to PPA are located in the menu Peak Pairs. The first command to
be applied to a new image is the Power Spectrum command to calculate the power
spectrum of the image:

PeakPairs —; iz D: Power Spectrum of QuantumWire
Fourier Space Noise Filter » Power Spectrum

v

Real Space Noise Filter Bragg Filter...

Set Reference Base Vectors

Motif Detection »
Find Peaks 4

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project »

Image Group 4

Analyze Peak Points
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Now, select the HREM mouse tool, and click on

desired spots to apply Bragg filter. The usual choice is P B & R @
to select the brightest spots in the spectrum, but those L
corresponding to higher harmonics can also be selected:

The user doesn’t need to hit the spot exactly, because
PPA looks for the local maxima near the selected point. N N o /

Anyway, if necessary, you can zoom in the spectrum
before hitting peaks using the DM zoom tool:

= D: Power Spectrum of QuantumWire

Hint: if you wish to delete any spot,
just click on the mouse mark again
with the SHIFT key down.

Hint: Symmetry in the selection for
each spot is assumed.

IMPORTANT: First and second chosen spots (numbered as 1 and 2) will define the lattice
basis vectors. These spots should be apart from the vertical or horizontal of the central spot, in
order to obtain maximum resolution.

Don’t be surprised if the central spot is not present in the power spectrum. It just indicates that
the mean intensity of the image is zero.
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We are now ready to apply Bragg Filter. This process creates an image where the contrast
resulting from the ordered regions is clearly distinguishable from the background intensity.

PeakPairs

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project

Image Group

Analyze Peak Points

4 Power Spectrum
< Bragg Filter...

ti= D: Power Spectrum of QuantumWire

Let us select the first option (small window,
oval ratio=1) and press the OK button, and the
Bragg filtered image will appear immediately.

If Bragg filter parameters are properly
chosen (big masks and a sufficient number
of peaks), the resulting filtered image will
preserve the location of maxima. The great
advantage in using the filtered image is the

reduction of noise.

E% Bragg Filter X

Project Name: | Project1
[Jinvert Peaks

Size:

Apply

Custom v 30.9

Smoothing Width: | 5.0
[JovalRatio: |0.5
45.0 degree

OK

pixels

Direction:

Cancel

NOTE: If you are interested in black spots, the
Invert Peaks will be checked here.

The shape and size of the Bragg filter must be
adjusted such that no loss of information occurs. In
this dialog box we can determine the size (in pixels),
smoothing width (in pixels), oval ratio(height/width)
and direction (in degrees) of mask spots.

By pressing the Apply button, the mask described by
the chosen parameters will be redrawn, as it is shown
in the example on the left.

i Bragg Filter X

Project Name: | Project1

[Jinvert Peaks

Size:
Custom v 30.9 pixts Apply
Smoothing Width: ISO—
[Jovalratio: [0.5
Direction: W degree

OK Cancel

7

= L: Project1 Bragg Filtered QuantumWire
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Peak Detection (for simple structure images)

IMPORTANT: Peak Detection uses two base vectors information (unit cell) to find a set of
good intensity peaks. The Bragg filter defines the two base vectors automatically. However,
in the case of the Real Space Noise Filter, the two base vectors should be defined
manually using the Set Reference Base vectors command.

Once we have a Bragg filtered image, the next step is to locate peaks of intensity in the image
by using the Find Peaks menu commands.

The first step of peak detection is peak | Peakpairs

1dentification based on their intensities. gouterSpaceiNoiscibilter ’
Real Space Noise Filter »

The Discriminate Peaks command detects Set Reference Base Vectors

all local intensity maxima in the image, and Motif Detection »

calculates the histogram of peak intensities. Find Peaks 8
Find Peak Pairs Refine Peak Positions...
Displacement Maps Remove Peaks
Define Reference Add Peaks

Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project »

Image Group »

Here, we use Test image.dm3 as a sample data. First, we apply the Bragg filter using all the
spots in the Power Spectrum. When the command Discriminate Peaks is selected, a new
window showing the histogram of all the peaks found in the image will appear. The histogram
allows the user to locate different sets of peaks, based on their intensities. All peaks of
intensity lower than this threshold are discarded.

The Discriminate Peaks will also open the HREM Histogram control tool. If you want,
you can change the histogram range as well as the number of bins. The default range of the
histogram is set to the maximum and minimum of the peaks. When you change these values,
push the “Apply” button.

%= F: Peak Histogram of Project2 Bragg Filtered Test image [l o)==
200 = HREM Histogram X
150 Select threshold and press OK
y | E
Min: [1.2947 Max: [3.127

P No of bins: | 100

: Cancel Homeﬂ Apply)
: : N

i ;
2.705 He———0.442 ———le
[ )

1.4 1.6 1.8 2.0 2.2 2.4 26 2.8 3.0

TIPS: If you want to analyse black spots (hollows or dips), you have to check Invert Peaks
when you create a project.

10
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Once the histogram is shown, the user should select the intensity threshold for identifying
which peaks will be used in further analysis. To do so, just click the mouse on the histogram,
and select the desired range of peaks. The left side of the selection made in the histogram will
be used in the following Refine Peak Positions command.

‘ ,*, L ’f 2 A / )/ | W] iz F: Peak Histogram of Project2 Bragg Filtered Test image [olf® =)

k Select t 200

E Select and move objects

i '
2.705 He————0.442 ——— e

14 16 1.8 2.0 2.2 2.4 26 2.8 3.0

The discovered peaks will be classified to red or blue depending on the peak values: red
indicate the peak that is higher value than the selected threshold, while blue indicate the peak
equal to or lower than the threshold. The peak colour will be dynamically revised by changing
the threshold (the left-edge of the Range ROI).

HREM Histogram X
Select threshold and press OK

Min: |1.2947 Max: |3.127

No of bins: | 100

§ancel | | Home | | Apply
4

When you satisfy the threshold by looking the motif markers (red or blue), push the “OK”
button of the Histogram tool, or the “Cancel” button to stop the process.

11
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Once the range of peaks is selected, the next step is to refine the peak positions using the
Refine Peak Positions.

e The following dialog box appears:
Fourier Space Noise Filter » -
Real Space Noise Filter » & Find Peaks X

Set Reference Base Vectors Peak Threshold: | 0.825
Motif Detection 4

Typical Peak Width (FWHM): I 3.0

Find Peaks » Disgrimi
[ Refine Peak po;mons__,> FWHM: Full-width at Half-Maximum
Find Peak Pairs

Show All Local Maxima

Displacement Maps Remove Peaks

Define Reference Add Peaks OK Cancel

Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project »

Image Group 4

Peak Threshold indicates the minimum intensity of a point to be considered as a
valid peak. Peak threshold value is automatically read from the left side of the
selection made in the histogram. However, the user can manually modify this value,
if necessary.

Typical Peak Width indicates the size (FWHM) of the typical peak in pixels. The
peaks (columns) within this value will be merged into a single peak.

When Show All Local Maxima is checked, all the peaks at the local maxima is also
displayed in blue in addition the refined peaks (in red).

By pressing OK, we get a first set of peaks shown as coloured spots over the filtered image.
Blue dots represent local maxima (8-neighbourhood) on a pixel basis. Red dots represent
refined maxima at sub-pixel resolution. Sub-pixel resolution is achieved by fitting a 2D
quadratic function and calculating the maxima, as described in the reference for the algorithm
in the Introduction section.

iz H: Project1 Bragg Filtered Test image o -8

Sometimes, extra peaks are obtained in this automatic Peak Finding process, especially at the
borders of the image. Repeating the Find Peaks command with a new Peak Threshold, all
peaks in the border of the image will be discarded and won’t be considered in any further
calculations.

12
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Motif Detection (for complex structure images)

IMPORTANT: Motif Detection uses two base vectors information (unit cell) to find a set of
good motifs. Thus, the two base vectors should be defined manually using the Set
Reference Base vectors command. At this point, a new project will be created.

In cases where the repeating unit in the image is more complex than a single dot, such as a
dumbbell, an alternative, more complex way to determine the lattice may be useful. Thus, the
Motif Detection has been implemented. Here, we explain the Motif detection using the
image QuantumWire.dm3.

First, a rectangle should be defined using the Rectangle ROI tool. The rectangle defines the
basic pattern that will be searched across the whole image using normalized cross-correlation.
For example, in this image, a cation location (an upper part of a dumbbell) may be a good
choice. Rectangle size and location is a critical decision in the accuracy of strain results. Let
us zoom in the substrate, and select a rectangle area around a cation.

"1 Rectangle
Add a rectangle ROI

Once the rectangle ROI has been placed, you can rotate the Motif ROI, if you want. To do so,
please select the Define motif in the Motif Detection submenu.

PeakPairs & H: Project1 Bragg Filtered QuantumWire

Fourier Space Noise Filter »
Real Space Noise Filter »
Set Reference Base Vectors
Define Motif

Refine Motif using high x-Corr Patches...

Motif Detection

v w

Find Peaks
Find Peak Pairs Discriminate Motifs...

Displacement Maps Refine Motif Positions...

Define Reference

Correct Scan Line Noise...

TIPS: You can rotate the ROI by dragging the yellow cross (+). You can adjust one of the
edge lengths by selecting the yellow edge and dragging the handle. You can adjust both edge
lengths by dragging the yellow cross when pressing the SHIFT key

13



HREM Research Inc. PPA for DM Manual

Once the Motif has been defined, select the Refine Motif using high x-Corr Patches in
the Motif Detection submenu. This command will refine motif using a high score cross-
correlation patches with the original motif. When you select this command, a dialog shown
below will open:

PeakPairs
Fourier Space Noise Filter »
Real Space Noise Filter » - _
E% x-Corr Histogram X
Set Reference Base Vectors
Motif Detection » Define Motif Minimum Motif Distance: | 10.0
Find Peaks » Refine Motif using high x-Corr Patches... > Show Original Motif
Find Peak Pairs Discriminate Motifs... oK Cancel
- Refine Motif Positions...
Displacement Maps

Define Reference

Correct Scan Line Noise...

After clicking OK, a new window will appear showing the histogram of all maxima found in
the Cross-Correlation map, obtained using the User-Selected motif and the whole image. At
the same time, the HREM Histogram control tool will appear as shown below.

iz P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire = 2=

HREM Histogram X
250 Select threshold and press OK

200-

50 Min: |0.5 Max: | 1.0
100 No of bins: W

:

In this case, we may observe two peaks in the histogram, corresponding to Ga and In cations
across the image. The default range of the histogram is set to 0.5 to 1.0. If you want, you can
change the histogram range as well as the number of bins. When you change these values,
push the “Apply” button.

Once the histogram is shown, you should select the intensity threshold for identifying which
peaks will be used in further analysis. To do so, choose the Select tool and click the mouse
on the histogram. Then, move the left edge of the selection to define the lower threshold.

‘<~‘ -\ Q J A / }/ . ‘ - L: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire [felfa ==
J H

Select 250

Select and move objects

0.96 +—0.04 =3}

0.50 055 0.60 065 0.70 075 0.80 085 0.0 085 1.00

The discovered motifs will be classified to red or blue depending on their cross-correlation
values: red indicate the motif, whose cross-correlation value is higher than the selected
threshold, while blue indicate the motif equal to or lower than the threshold. The peak color
will be dynamically revised by changing the threshold.

14
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ti= H: Project1 Bragg Filtered QuantumWire

Given that we are interested in the detection of both cations, we will select a threshold lower
than 0.9 to take all peaks into consideration.

= P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire [olfe)==

250-

‘ Eancel Home | | Apply

HREM Histogram X
Select threshold and press OK

Min: F Max: IT
No of bins: |200

When you satisfy the threshold by looking the motif markers (red or blue), push the “OK”
button of the Histogram tool, or the “Cancel” button to stop the process.

If you push the “OK” button, the first refined motif is calculated by
averaging all patterns associated to each point in the histogram above the
chosen threshold (0.91 in the figure). The averaged motif is automatically

shown:

S e

The third step of the Motif detection is calculating the cross-coefficients using the refined

motif. To do so, select the Discriminate Motifs command.

PeakPairs

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Correct Scan Line Noise...

Define Motif
Refin

Discriminate Motifs...

Refine Motif Positions...

15
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Then, this command will show a histogram of the cross-correlation between the refined Motif
and the whole image as well as the HREM Histogram control tool. This step is especially
useful in the presence of noise.

= T: Peak Histogram_X-corr of Refined Motif with QuantumWire o=

HREM Histogram X
“oo Select threshold and press OK
Min: [0.5  Max: | 1.0

2: No of bins: | 200
: [Cancel] [Home] [Apply]

Once the refined histogram is shown, the user should select the intensity threshold on the
refined histogram as before.

_m | A / /V . ‘ = T: Peak Histogram_X-corr of Refined Motif with QuantumWire oo )=
: -

Select and move objects =0

R Select !i w0 :

300-

250

The discovered motifs will be classified to red or blue as before. The peak colour will be
dynamically revised by changing the threshold. When you satisfy the threshold by looking the
motif markers (red or blue), push the “OK” button of the Histogram tool.

= H: Project1 Bragg Filtered QuantumWire [o][®@][=]

HREM Histogram X
Select threshold and press OK

Min: |0.5 Max: |1.0
No of bins: |200
(e (e (romy)

16
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The final step of the Motif detection is finding the refined motif centers (positions) by using
quadratic fitting to the cross-correlation peaks. To do so, select the Refine Motif Positions
in the Motif Detection submenu, which opens the dialog as shown.

PeakPairs <] - H
E&ﬂ Find Motif Centers X

Fourier Space Noise Filter 4
Real Space Noise Filter » Peak Threshold: I 0.69
Set Reference Base Vectors Show All Local Maxima
Motif Detection » Define Motif Show stacked motif
Find Peaks 4 Refine Motif using high x-Corr Patches...

OK Cancel

Find Peak Pairs oy
Displacement Maps Refine Motif Positions... )

B S

Define Reference

Correct Scan Line Noise...

If the motif peaks within the minimum motif distance are found, these peaks will be merged
into a single peak position.

Then, the refined motif positions (the centers of the motif boxes) are marked by the red small
boxes, and the second refined motif will be displayed. When Show All Local Maxima is
checked, all the peaks at the local maxima is also displayed in blue. (Here, no blue boxes are
shown.

Refined
motif

IMPORTANT: In the case of Motif Detection, the reference base vectors should be selected
using the Set Reference Base vectors before applying the Find Peak Pairs command.

17
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Peak Pairs Determination

IMPORTANT: Peak Pairs are calculated using two basis vectors. The Bragg filter defines
the two base vectors automatically. However, in the case of the Real Space Noise Filter or
Motif Detection, the two base vectors should be defined manually using the Set
Reference Base Vectors command.

Once all peaks or motif centers have been selected, Peak Pairs should be calculated using the
Find Peak Pairs command. This process will find all pairs of peaks along the predefined

two basis vectors.

PeakPairs

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project

Image Group

Analyze Peak Points

Distortion Analysis
Histogram from Spreadsheet
Show/Hide

Add Color Marker

Create Vector Map...

Distortion Correction

Help

Analyze Equivalent Columns...

ir5/H: Bragg Filtered Test image.

-

Motif Detection (complex structure)

18
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Displacement and Strain Maps calculation

Once all Peak Pairs have been determined, we can proceed to the calculation of displacement
maps using the command Displacement Maps. This generates horizontal and vertical
displacements (D1h, D1v, D2h and D2v).

PeakPairs = Q: Projectl D1h [f=-=-J&ES) | & T: Project: D1v [el@][=]

Fourier Space Noise Filter »
Real Space Noise Filter »
Set Reference Base Vectors
Motif Detection »
Find Peaks »

)ﬁmm_

< Displacement Maps j

mﬂmce
Correct Scan Line Noise...
Strain Map...
Repeat Project...
Project 4
Image Group »

Technical note:
PPA uses an automatic selection of contrast and the temperature color scale for
displaying image values. Default color range is +1 pixel.

If you prefer a grey scale or a different contrast limit, press the right button on the
image, and modify ImageDisplay options properly.

Changing this option will not change the actual values, only its appearance.

A very important step is to define the Reference Area, that is to say, the area that is considered
to correspond to the reference lattice.

All displacements and strain values will be referred to this area. Use the Rectangle ROI tool
(region of interest tool) to select an area on any one of the Displacement images (D1h, D1v,
D2h or D2v):

= Q: Project D1h (=8 (Ecn =

i ! Rectangle
Add a rectangle ROI

19
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Once the Rectangle ROI has been placed, the user should select the Define Reference
command. This will change the displacement values, so as to obtain a uniform displacement
in the chosen reference area.

PeakPairs = P Project1 D1h [E=slmeEs] | g v: Project1 D1v [EE=]
Fourier Space Noise Filter » . ~ : 1
Real Space Noise Filter »

Set Reference Base Vectors
Motif Detection »
Find Peaks »

Find Peak Pairs

Dis

Define Reference Sl iz [=SIE]E=]

Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project 4

Image Group »

Analyze Peak Points

Analyze Equivalent Columns...

The Define Reference command makes the Rectangle ROI rotatable. You can change the
size and angle as shown below, if you want:

2 : ot D1 (== You can adjust the edge length by selecting
the yellow edge and dragging the handle,
and rotate the ROI by dragging the yellow
cross (+).

You can adjust the both edge lengths by
dragging the yellow cross when pressing the
SHIFT key.

When you change the ROI shape or displace the ROI, the average displacement within the
ROI will be automatically set to zero.

The final step is the determination of strain maps (exx,eyy,exy and eyx) at the desired angle.
When the Strain Map command is selected, the Strain Map dialog appears. Here, you can
specify the coordinate axes to display the strain maps using Angle of x-axis to horizontal. If
the angle is set equal to 0, horizontal and vertical directions are assumed to be x and y
coordinate axis respectively.

= Strain Map S5

Option

Find Peak Pairs

Displacement Maps
Angle of x-axis to horizontal: | 7.5
Define Reference g

Show the following images

Correct Scan Line Noise... [V] Strain Matrix

- () Independent
Strain Map... , @ Symmetric

[] Mean Dilatation

Repeat Project... Rotation Angle
Project 4 rla‘/
Image Group > Cox )

20
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The angle of x-axis to horizontal may be determined graphically. To do so, just add a Line
ROI on the original image, along the desired direction of x-axis, before issuing the Strain
Map command.

- F: QuantumWire

Liled o 2 o

" Line
Add a line ROI

Once the OK button is chosen, a set of 4 images corresponding to (exx,Cyy,exy and eyx) are
obtained. The mean dilatation and Rotation angle are additional images available.

There is an option for strain representation (Overlay):

DESCRIPTION Full image Detail

i K: Projectl exx

No overlay:
Continuous strain
maps are shown.

gz K Projecti oxx [ ][ -G [

Hint: If you prefer a grey scale or a
different contrast limit, press the right
button on the image, and modify
ImageDisplay options properly.

|

Overlay: - G Project ex
Strain maps at
each atomic
column are
shown with
colour dots over
the original
images.

21
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Setting the Reference Base Vectors

It is possible to manually set the reference base vectors.
To manually define the Reference Base vectors, use the HREM Mouse Tool to select 3
points in the order (origin of both vectors, terminal point of vector 1, terminal point of vector

2), so that the directions of the desired reference base vectors are described by the directions
of vectors 1->2and 1->3.

lgcaLe}&%@

. 8

a B 8
N NN N

™
L]
L

Approximate directions
specified by the user

When applying the Set Reference Base Vectors command, the dialog shown below will

open.
PeakPairs
Fourier Space Noise Filter »
e S DaceiNoeRItey ’ i Set Reference Base Vectors X
Set Reference Base Vectors X
c > Project Name: | Projecti]
Motif Detection 4
Find Peaks > [Jinvert Peaks
Find Peak Pairs Base Vector 1 (1->2) |Auto-divide v | 1
Displacement Maps
V r -> ivi v
Define Reference Base Vector 2 (1->3)  Auto-divide | 1
Correct Scan Line Noise... OK Cancel
Strain Map...
Repeat Project...

Normally, the reference base vectors along the user specified directions will be automatically
estimated. However, if the unit is not simple, the algorithm to determine a repeating unit will
fail. In this case, you can specify the number of repeating units along two directions. In this
case, 5 and 6 along the base vector directions 1 (1->2) and 2 (1->3), respectively.

NOTE: If you are interested in black spots, the Invert Peaks will be checked here.
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The precise magnitude and direction of both reference base vectors are calculated using a
least-squares fitting to all the peaks within the parallelogram defined by two vectors 1->2and

1->3.

t- C: Project1 LPF of PPA Test 1 = R )
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Real Space Noise Filters

While Bragg filtering is very useful to reduce noise, some researchers may prefer other
alternative noise filtering techniques in real space. There are two alternative noise filtering
commands: Adaptive Wiener Filter and Low Pass Filter. The techniques have no way to
determine automatically the basis vectors, and they should be determined manually by using
the Set Reference Base Vectors command

Adaptive Wiener Filter

The Wiener filter is widely used for image restoration and calculates the optimal filter for the
removal of noise from a signal which is corrupted by the measuring process itself. It assumes
that if noise is present in the system, then it is considered to be additive white Gaussian noise.

In a typical Peak Pairs session, if Wiener filtering is desired, it is usually the first operation to
be applied to the original image. When applying the Adaptive Wiener Filter on the front
image, the user should decide the size of the windows used for calculating the Adaptive
Average and the Noise Estimation, as follows:

PeakPairs G . "
E%j Wiener Filter X
Fourier Space Noise Filter » /——

Real Space Noise Filter Adaptive Wiener Filter... ’ New Project: | Projectl
0

Set Reference Base Vectors D Invert Peaks
Motif{Detection i’ Adaptive Average: | 1 x2+1pixels
Find Peaks 4

Noise Estimation: | 1 x2+1pixels
Find Peak Pairs
Displacement Maps OK Cancel

Define Reference

Correct Scan Line Noise...

NOTE: If you are interested in black spots,
the Invert Peaks will be checked here.

Strain Map...

If the standard deviation of the local area is small, then the pixel value will be replaced by a
local average. On the other hand, if the standard deviation of the local area is large, then the
pixel value will not be modified. Thus, the new pixel value will be between the old value and
the local average according to the local standard deviation.

The result of the Wiener filtering applied to Test image.dm3 is shown below. The insets show
enlarged parts.

- I: Project] AWF of PPA Test 1

Left: Original; Right: Wiener (Adaptive Average =3, Noise Estimation=3)
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Low Pass Filter

In order to generate a Low-Pass filtered image, use the Low Pass Filter command on the
front image. The strength of the filter is defined by the Radius of the mask in pixels (the
larger the radius, the stronger the filter):

PeakPairs
Fourier Space Noise Filter > % Low Pass Filter X
Real Space Noise Filter 4 Adaptive Wiener Filter...
Set Reference Base Vectors ( U e bl > New Project: | Project3
Motif Detection 4 D Invert Peaks
Find Peaks 4 Radius(pixel): | 2.0
Find Peak Pairs OK Cancel
Displacement Maps
Define Reference . .
- NOTE: If you are interested in black spots,
Correct Scan Line Noise... .
. the Invert Peaks will be checked here.

The new pixel value will be a local average with a Gaussian weight (mask) of the defined
radius. You can specify a radius of less than one pixel.

In the following figure, the resulting images after the application of a Low-Pass filter to the
lower left part of Test image.dm3 with different radius are shown:

's N 7 N

o @] =]

iz B: PPA Test 1 = A: Projectl LPFof ... [ o || @ |[ 83 ] || g A: Project1 LPFof ... [ o |[ @ |[ 2|

Original image
(right-lower corner only)

Low Pass Filtered
(radius=0.8 pixels)
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Geometric distortion correction

All optical systems distort the images they form. CCD cameras and scanners (for digitising
negatives for example) introduce additional distortions. If these geometric distortions are
fixed (what is usual for a given system), it is possible to eliminate them. This is valid not only
for projector lens distortions but also for any other systematic distortions present in the image.

In order to correct the distortions, an image of a perfect crystal is needed. We explain here
distortion correction using a pair of images with the same distortion, Test image.dm3 and
Substrate.dm3, the latter of which corresponds to an image of a perfect crystal.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in
the usual way by selecting relevant spots in the Power Spectrum.

iz B: Substrate [folfe- ===

i Bragg Filter

Project Name: [ Projectt
[invert Peaks

Size:
custom v [200  pixels | Apply
Smoothing Width: [5.0
Movalratio: [10
Direction: [0.0  degree

OK Cancel

Then calculate the Peak Pairs using the usual commands (Find Peaks followed by Find
Peak Pairs). If we analyse the displacements with the Displacement Maps command, we
can observe that the image of a perfect crystal is distorted as shown below.

= N:ProjectiDih [o |[@ |[R ] | gizQ: ProjectiDlv. [ |[@ ][ =]

= P: Projectl D2h [o][@ =] | g=R:Projectip2v [ @ ][ =]
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The distortion information obtained for the perfect crystal image can be used to correct
distortions in any other image with the same distortion. In order to obtain the distortion
information, select the image with Peak Pairs information, and apply the command Obtain
Distortion Info.

Analyze Peak Points ¢ St Distortion Info of Substrate o o)==
Analyze Equivalent Columns...
Distortion Analysis »
Histogram from Spreadsheet

Show/Hide

v

Add Color Marker
Create Vector Map...

Distortion Correction 4 Correct Distortion..
Obtain Distortion Info ‘)

Help D‘

The new image with distortion information will be created. This Distortion Info image can be
saved to disk (e.g., Distortion Info of Substrate using Save As command) and used in further
analysis of the image having the same distortion.

In order to rectify the original image using the distortion information obtained from the
perfect crystal image, just apply the Correct Distortion on the Target Image as follows:

Analyze Peak Points t.,.: Correct Distortion lﬁ

Analyze Equivalent Columns...

v

Distortion Analysis Target Image: [D:Testimage 918k ']

Histogram from Spreadsheet

. Distortion Info: [S: Distortion Info of Substrate 2758k v]
Show/Hide »

Add Color Marker oK ] [ Cancel ]
Create Vector Map...

Distortion Correction < Correct Distortion... S
ain Distortion Info

Help 4

Rectify Image...

Here, Select the Target Image (the image to be corrected), and the Distortion Info (the
image created by the Obtain Distortion Info command). Here, we use the Test image.dm3
and the Distortion Info obtained from Substrate.dm3.
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This will produce a corrected image, where all the
distortions estimated from the perfect crystal image
have been eliminated.

:?: F: Test image

(oo )

We can now proceed to analyze this image in the
usual way to get the final results:
1. Power Spectrum

2. Bragg Filtering

3. Find Peaks

4. Find Peak Pairs

5. Displacement Maps
6. Define reference

7. Strain maps

The strain maps before and after distortion correction:

-

= W: Project4 exx o |[@ ][] | g Y: Projects eyy

===

(===

= J: Project2 exx = L: Project? eyy

(===

-

= M: Project2 exy = O: Project2 eyx [o@][=] te Z: Projectd exy [S][@][=] | & AB: Projectdeyx [ |[= |[ 52|

before correction after correction

If we plot a horizontal profile across exx and a vertical one across eyy, we get the expected
results (exx=0.1 and eyy=0.05) after distortion correction.

= D: Profile Of Projectd exx [E=n[E=R~=|

= G: Profile Of Project4 eyy

o.
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Additional functions

Peak Analysis (Analyze Peak Points)

The Analyze Peak Points command applied on the project image, such as Bragg filtered
image, will generate an output in spreadsheet including the following information (one row
for each lattice peak):

- Peak position at sub-pixel resolution (x,y coordinates)
- Peak intensity
— Strain tensor at each peak points (exx,eyy,exy and eyx): only after Strain Analysis.

Displacement Maps -
¢ D Lattice Points of Project3 Bragg Filtered PPA Test 1
Define Reference £ 4 Height axx ayy axy ayx -
) . Wean |237.574 | 238.692 282634 |0.0273326 |0.0186343 |-0.00534172|-0.00987758| |
Correct Scan Line Noise... std_|137.592 136.723 0.113333  |0.0430278 |0.0317812 |0.0146783 | 0.01439291
) P1_|s.72518 11.8867 2.68881 -0.066703 | -0.0428194 |0.0263026 | 0.0260612
Strain Map... P2 |7.13892 241.753 2.852 -0.0333832 |0.0203174 |-0.01035 |-0.00651274
23 7.14438 229.872 2.81462 -0.0407684 | -0.00025243/0.00138291 | -0.00871415
Repeat Project P4 7.20828 205.776 2.7538 -0.030673 -0.0076317 | -0.00267347-0.0151094
P5 |7.20914  |217.882 2.73 -0.0375265 | -0.00326502| -0. 00502334 -0. 0186023
Project » P5__|7.22218 273.178 2.34695 -0.0368814 |0.0397605 | -0.0101031 | -0.0231307
P7_|7.22584  |254.188 2.77386 -0.0361018 |0.047856 | -0.0188327 |-0.0149577
Image Group » P8 |7.24878 266711 2.63983 -0.0398632 |0.042157 | -0.0012523 |-0.0256778
Pg|7.30835 193.864  |2.91845 -0.033584 | -0.00427666 0. 00582282 | -0. 00279915
] P10 |7.33796 291.671 2.79103 -0.0388477 |0.0460278 | -0.0152384 |-0.0186443
Analyze Peak Points PIr_|7.a1728 304.227 2.75082 -0.039785 |0.0461539 | -0.0187371 | -0.0260204
P12_|7.42a08 181.897 2.89344  |-0.039971 |0.0038951 |0.00115376 |-0.00858061
Analyze Equivalent Columns... P13_|7.54168 169.871 2.66301 -0.0433459 | -0.00104136| 0. 00535647 | -0.0108181
. . . > P14_|7.58362 316693 2.73329 -0.0418819 |0.0348251 | -0.0202497 | -0. 026883
Distortion Analysis PI5_|7.7027 157965 [2.6861 -0.0800217 | -0.00907148 | 0. 00656087 | -0. 00788249
. P16 _|7.73629 329.073 2.66285 -0.042688 |0.0332012 | -0.0172725 | -0.0306297
Histogram from Spreadsheet PI7_|7.87528 146.064 | 2.76203 -0.0403106 | -0.00703335|0. 0125334 | -0. 00436709
o P18 7.91922 341. 448 2.85664 -0.0358251 |0.0306097 -0.0253737 | -0.0383183
ShOW/HIde b P18 |8.07366 353.783 2.82847 -0.0327167 |0.0273665 -0.0159979 | -0.0378463
P20 |8.11374 134.204 2.639 -0.0481512 | -0.0159224 | 0.0173555 -0.00132639
Add COIO' Ma'ker P21 8.2421 366.123 2.79355 -0.0347414 |0.0316551 -0.0269653 |-0.0378794
Create Vector Map... P22_|3. 40508 122. 458 2.68165 -0.0506372 |-0.0154673 |0.0143573 | -0.00359978
P23_|3.50759 378452 2.92367 -0.0383204 |0.0225834 | -0.0252833 | -0.0390471
Distortion Correction » P24 |s.6783 110.53 2.73576 -0.0523373 | -0.00043632(0.0197727 | -0.00410889
P25_|8.72908 390.634  |2.8988 -0.0420334 |0.0165246 | -0.0227335 | -0.0380875 | _
Help » 4 » _|

It is also possible to get a histogram from the Spreadsheet by using the Histogram from
Spreadsheet command, thus obtaining a different histogram for each column in the
spreadsheet.

Displacement Maps th Gt exx E@@]

Define Reference v Lt eyy (= =]fE=]

Bk oy B

b sien == |
0 B

Repeat Project... ®CXx == =] ]

Project > = F: Height [ ®=]

Image Group |:
90-

Analyze Peak Points

Correct Scan Line Noise...

Strain Map...

Analyze Equivalent Columns...

Distortio|

Histogram from Spreadsheet

Add Color Marker
Create Vector Map...

Distortion Correction »

Help »

TIPS: When you select this command, a dialog will open, where you can select the data to be
displayed.
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Atomic Column Analysis (Analyze Equivalent Columns)

Once Peak Pairs have been located, it is possible to analyze atomic column positions. This is
very useful when there are more than one atomic column within a unit cell. For example, in
the case of [110] projection of InP (the zincblende type materials), we can evaluate cation
and/or anion atomic columns. In order to do so, go through the following steps (on the

zincblende.dm3):
- Calculate Peak Pairs in the usual way

- Bring the original raw image to
frontmost.

- Choose the area of interest on the
original image using the Rectangle ROI
tool.

- Select atomic column(s) to be analysed
using the HREM mouse. (Here, we
select a set of cation and anion columns)

- Bring the project image with Peak Pairs
information to frontmost.

- Apply the Analyze Equivalent
Columns command

= N: Project4 AWF of zi

ncblende_110

.
’

-

___.___‘__

P "'7‘Fﬁ/ )

al _
E=0(EEE

oo
PN

Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...

Project »
Image Group »
Analyz

Analyze Equivalent Columns...

Distortio 15 »

Histogram from Spreadsheet
Show/Hide 4
Add Color Marker

Create Vector Map...

Distortion Correction »

Help 4

D g

s

7
1
|
|
|
|

L]

B

-,

-

All the columns in the selected area will be shown in the image, and the intensity of each

column will be stored in a spreadsheet.
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- U: Distance_zin... [ o | @ |[n25] |
<

— = tiz AD: Peak_zincblende_110 o |[®@][=
std | 0.0886919 A7 141 (23 A2 Y2 22 -
Pos? |6.36691 mazn |101.92 106. 428 0.306528 104. 096 112. 408 0.0830263 |
Pos2 |6.36616 std | aa. 1837 44,1373 0.00148186 |44.1625 441416 0.000641297
Pos3 |6.37164 Pos? |35.7585 43.9015 0.310308 37.9353 498847 0.0832183
Pos4 [6. 40335 Pos2 |31.5959 58.2847 0.305591 33.7563 64.273 0.0818131
Poss |6.38842 Pos3 | 27. 4481 72.7096 0.30573 29.6055 787041 0.0829192
Posd |6.34961 Posé |35.6929 95. 4985 0.304949 37.9096 101.507 0.0836382
Pos7 |6.37638 Poss |31.543 109. 836 0.307186 33.7247 115.84 0.0841879
Pos8 | 6. 40828 Post | 39.8894 81,0467 0.30447 420678 87.011 0.0830656
Posg |6.374 Pos7 |27. 348 124.263 0.30509 29.5528 130. 245 0.0826102
Posib|6. 37056 Pos8 | aa. 0382 66. 6424 0.305346 46.2168 72.669 0.0830897
< Posg |52.a104 37.8367 0.306119 54.5977 43,8237 0.0837043

Posi6|as. 2239 52.2539 0.305862 50.3818 58.2479 0.0817484 | _

Aewvwvlan 2040 400 EAC A AAANY A A4 Annc 490 £A A AnAnAEN

< » _l

If there is more than one column, the user will % Analyze Equivalent Columns M
have the option to evaluate the distances

between the columns. Distance |Ang|e | option |

M1 @2 O3

Distances from the checked point(s) to
other points wil be evaluated.

[ ok ][Cancel]J

I

If.there are more ‘Fhan two columns, the user ¥ Analyze Equivalent Columns u
will have the option to evaluate the angles

subtended by two neighbour columns. Distance Angle |opuon |

(1 @2 3

Checked point(s) wil be a vertex of angle(s)
subtended by two other points.

o) Comi ] |

(.

You can see visually the distribution of distances using the Histogram from Spreadsheet
command:

B S

TIPS: When you sclect Histogram from Spreadsheet command, a dialog will open,
where you can select the data to be displayed.
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Distortion Analysis (from v4.0)

From information on the peak positions of a complex structure, you can analyse a peak
distance and angle (a length and angle of the peak-pair vector). Furthermore, in principle, you
can calculate a rotation of a structural unit (e.g. tetrahedron or octahedron), or even a distance
from the ideal/virtual position to the observed peak. However, such an advanced analysis
requires some skill in programing. The Distortion Analysis of the PPA will provide an easy
way to perform such an analysis using the DM script.

For the Distortion Analysis we first perform Motif detection, and then on the original image
select the peaks to be used in the analysis using the HREM mouse. Next, write a script to
measure distortions in the script window as shown below:

e DA o | @ |
1 PPABeginDA() // Always use this function at the beginning

2 {

3 // Calculate the vector from an ideal position

4 image VirtualPeak := (PPAPeak(l)+PPAPeak(2)+PPAPeak(3)+PPLPeak(4))/4
5 image displacement := PPAPeak(5) - VirtualPeak

1) PPASaveResult ( gIdeal Positionh, VirtualPeak )

7 PPASaveResult ( gDisplacementh, displacement )

8 PPAPreplArrow( gDisplacementh, displacement, PPAPeak(5) )

9 PPAPrepColorMap( gDisplacementh, distance (displacement), PPAPeak(5S) )
10 }

11 PPAFinishDA() // RAlways use this function at the end

12

< I P

T

Before executing the script, place a rectangle ROI on the original image to show the area to be
analysed. Then, put the project image at the front most, and run the script by pushing
“Execute” button. You will get a dialog similar to the one that appears when you select the
Measure Distortion command.

TIPS: If you have no error messages, you may want to save the script for a future use by

clicking “Save As...” button. As you see the example script, you have to respectively use
PPABeginDA() and PPAFinishDA() at the beginning and the end of the script in addition
to your analysing code.

NOTE: This script will measure a distance from the virtual position (the center of the
four peaks from peak #1 to peak #4) to the observed peak #5, and save some information
for a later use. Here, the functions with the prefix of PPA are provided with the PPA
plug-in v4.0 or later and explained at the end of this section.
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The following shows the menu for the Distortion Analysis.

Analyze Equivalent Columns...

Distortion Analysis » Measure Distortion...
Histogram from Spreadsheet Show Motif Positions...
Show/Hide » Show Arrows...

Add Color Marker Show Color Map...
Create Vector Map... Update Front Image...
Distortion Correction 4

The first step of the Distortion Analysis is to measure distortions by launching the command
Measure Distortion... to run the saved script, or by directly executing the script from the
script window as described above. Before launching the command, place a rectangle ROI on
the original image to show the area to be analysed. Furthermore, on the original image select
the peaks to be used in the analysis using the HREM mouse. Then, put the project image at
the front most, and select the Measure Distortion command. This command will open the
dialog shown below:

% MeasureDistortion X

Select Evalustion Script = ...tAnalysis¥TestMean.s
Qutput Spreadsheet Name:

| QuantumWire_SS1
Find Peaks within | 5.0 pixels

OK Cancel

Here, you can select your saved script file to evaluate distortions, and specify the output
spreadsheet name. If you directly execute the script from the script window, you will have a
dialog without the file selection capability.

Peaks will be searched in the area specified by Find Peak within value from the
corresponding points in the Motif. If the peak is not found within the specified region, you
will find NaN in the spreadsheet.
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The measured distortion can be visualized using the commands Show Arrows... or Show
Color map... when the spreadsheet obtained by the analysing script is at the front most. Then,
the dialog shown below will open. After selecting one of the spreadsheets, the same dialog
will open.

E% Show Arrows X E% Show Color Map X
Show Arrows for |testlarrow v Show Color Map for |testlcolormap v
X,y components v x | 10 Display Type
(® Polygon
Show Motif Positions
(Ocirde  Radius | 5  Pixel
OK Cancel

Display Range (Percentile)
Low |0 % High 100 %
Show Motif Positions

OK Cancel

The commands Show Arrows... and Show Color Map... will work for the spreadsheet that
includes the information saved by PPAPrepArrow and PPAPrepColorMap, respectively.

When the project is at the front most, for which the distortion is measured, the dialog to select
a spreadsheet data will open. Then, follow the same steps of showing the arrows or color map.

TIPS: You can modify the appearance of the map using the Update Front Image...
command, if the front-most image is an arrow or color map.

You can check the potions of the approximate motif centres using the Show Motif
Positions... command.

Description of the functions
PPABeginDA()

should be called at the beginning of the script
PPAFinishDA()

should be called at the end of the script

image PPAPeak( number n )
generates a list of column positions for the peak #n.
image PPALength( image vector)
calculates the vector length.
image PPALength( image pointl, image point2)
calculates the length of the vector (pointl to point2).
image PPAAngle( image vector )
calculates the vector angle, anticlockwise from the horizontal axis.
image PPAAngle( image pointl, image point2 )
calculates the angle of the vector (pointl to point2), anticlockwise from the horizontal axis.
image PPAAngle( image pointl, image point2, image point3)
calculates the angle between two vectors (pointl to point2, and pointl to point3),
anticlockwise measured from point2 to point3.

void PPASaveResult( string “name”, image result data )
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saves result_data with an identifier “name” to the spreadsheet.
if result _data is vector, its coordinates (x, y), length and angle (measured anticlockwise from
the horizontal axis) will be saved to the spreadsheet.

void PPAPrepArrow( string “name”, image vector data, image start_point)
saves the vector data and the start point to the spreadsheet for an arrow map.
void PPAPrepArrow( string “name”, image angle, image start_point)
saves the unit vector with the specified angle and the start point to the spreadsheet for an
arrow map.
void PPAPrepColorMap( string “name”, image scalar_data, image display point)
saves the scalar data and the display point to the spreadsheet for a color map.

Sample code
PPABeginDA()

// calculate the vector from an ideal position

image VirtualPeak := (PPAPeak(1)+PPAPeak(2)+PPAPeak(3)+PPAPeak(4))/4

/I Here, we define the image “VirtualPeak™ to which the center of the four peaks saved.
image displacement := PPAPeak(5) - VirtualPeak

PPASaveResult( “Ideal Position”, VirtualPeak )

PPASaveResult( “Displacement”, displacement )

PPAPrepArrow( “Displacement”, displacement, PPAPeak(5) )

//calculate angle between two vectors Peak(5) to Peak(2), and Peak(5) to Peak(1)
image angle := PPAAngle( PPAPeak(5), PPAPeak(2), PPAPeak(1) )
PPASaveResult( “Angle”, angle )

PPAPrepColorMap( “Angle”, angle, PPAPeak(5) )

PPAFinishDA()

Another sample code

PPABeginDA()

// Here, we define the image “peakn” to which the coordinates of the peak #n is saved.
image peakl := PPAPeak(1)

image peak2 := PPAPeak(2)

image peak3 := PPAPeak(3)

image peak4 := PPAPeak(4)

image peak5 := PPAPeak(5)

// calculate the vector from an ideal position

image VirtualPeak := (peak1+peak2+peak3-+peak4)/4

// Here, we define the image “VirtualPeak™ to which the center of the four peaks saved.
image displacement := peak5 - VirtualPeak

PPASaveResult( “Ideal Position”, VirtualPeak )

PPASaveResult( “Displacement”, displacement )

PPAPrepArrow( “Displacement”, displacement, peak$ )

//calculate angle between two vectors Peak(5) to Peak(2), and Peak(5) to Peak(1)
image angle := PPAAngle( peak$5, peak2, peakl )

PPASaveResult( “Angle”, angle )

PPAPrepColorMap( “Angle”, angle, peaks )

PPAFinishDA()
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Correct scan line noise

There are situations in which the electron microscopy image is altered by the presence of
scanning errors, such as small beam deflections due to external electromagnetic fields, as well
as hysteresis effects during the ‘fly back’ between scan lines, that may severely distort strain
results. The presence of scanning errors may be identified as the presence of annoying stripes
in the strain results. In these cases, the option Correct scan line noise may be quite useful.

In order to show how to use this option, let us calculate strain results on the image
QuantumWire50Hz.dm3 in the usual way, as we did with QuantumWire.dm3 image in
previous pages. We will get the similar Power spectrum as shown below:

= C: Power Spectrum of QuantumWireS0Hz oo =

If we specify the lattice base vector (#1 and #2 as indicated), displacement maps shown below
may be obtained. As we may observe, a set of stripes is shown in these maps:

W= P: Project] D1h S (@[] | & V: Project1 DIv s@=

se1l o We can then Add a Rectangle ROI in one of the
Dt | 5: o 8 k o . .
: Displacement maps (here, the image U).

il Rectangle
| Add a rectangle ROI
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Then, press the Correct Scan Line Noise option to remove the stripes and determining a
proper displacement map.

PeakPairs - P: Project1 D1h [S @)= | & v: Project1 D1v EE=

Fourier Space Noise Filter »

Real Space Noise Filter »
Set Reference Base Vectors

Motif Detection »
Find Peaks »

Find Peak Pairs

Displacement Maps

Defin
Correct Scan Line Noise... >
Strain Map...

Repeat Project...
Project »

Tz W: Project1 D2v s E=

Image Group 4

Analyze Peak Points

You can extend the reference arF:a for the scan-line correction l:: . ﬂ
from the very top to the bottom lines, when you check “Correct
All Line” in the dialog. V] Correct All Line

’ OK ] [ Cancel ]

Unfortunately, in this example there is no perfect reference area from the top to bottom of this
image. Therefore, we have horizontal artefacts as clearly see in the images V and W.

The scan-line correction has a capability to merge multiple reference areas. Here, we use two
reference areas at the top left and the bottom right. Then, we can better perform the scan-line
distortion as shown below. There is no appreciable artefact observed before.

= Q: Project1 D2h |E=EEoE == e N: Projectt D1h [SI@ =] | @ Project1 D1v = [E=

= P: Project1 D2h
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Create Vector maps

It is possible to a create vector map from two vector components, such as D1h and D1v. To
do so, launch the Create Vector Maps command, and select two vector component images
of the associated vector map.

We explain here this function using the displacement maps, D1h and D1v, calculated from
Substrate.dm3. After launching the Create Vector Map command, select these two images,
D1h and D1v, and press OK.

PeakPairs - .. )
t-Z: Project3D1h  [iooo|[-E@-|[3a] | i AC: ProjectaDiv. [ o |[@ |[ 2]
Fourier Space Noise Filter >

Real Space Noise Filter »

Set Reference Base Vectors

Motif Detection »
Find Peaks »

Find Peak Pairs

Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...

Project 4 r—
gi= Create Vector Map ﬂ
Image Group » =
Select two components
Analyze Peak Points Horizontal: [O: Project3 D1h v]
Analyze Equivalent Columns...
AL Vertical: [R: Project3 Div V}
Distortion Analysis »
Arrow

Histogram from Spreadsheet Interval: |16 pixels
Show/Hide 4 length Scale: [1.0
A (Length = Scale * Interval)
Create Vector Map... Color: R |100 % G |0 % B |0 %

- = »
Distortion Correction
Help » -

Then, you will get a colour map corresponding to the vector magnitude, with arrows showing
the directions and magnitudes of the vectors as shown below:

té= K: Vector Map |E=EoE <)

The vector map here is a complex DM image, whose real and imaginary parts correspond
respectively to the Horizontal and Vertical images selected in the dialog.

38



HREM Research Inc. PPA for DM Manual

Image rectification

This command allows the user to correct any distortion from an image of a perfect crystal,
using Peak Pairs information. We explain here distortion correction using an image
corresponding to a perfect crystal, Substrate.dm3.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in
the usual way by selecting relevant spots in the Power Spectrum.

<

i Bragg Filter

ProjectName: [ Projectt

[Jinvert Peaks

Size:
custom v | [200 pixels | Apply
Smoothing Width: [5.0
Movalratio: [10
Direction: [0.0  degree

OK

Cancel

Then calculate the Peak Pairs using the usual commands (Find Peaks followed by Find
Peak Pairs). If we analyse the displacements with the Displacement Maps command, we
can observe that the image of a perfect crystal is distorted as shown below.

= V: Project4 D1h [a]®]|[=

= Y: Project4 D1v

= H: Project4 Bragg Filtered Substrate
AAR A S pn
$sl ey

Salete
BRI,

= X: Project4 D2h [ell®][= i Z: Project4 D2v o|[®][=]
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Given that the image corresponds to a perfect crystal, we can get a rectified image. In order to
do that, select the project image with Peak Pairs information, and then apply the Rectify
image command.

PeakPairs - .

Fourier Space Noise Filter »

Real Space Noise Filter »
Set Reference Base Vectors

Motif Detection »
Find Peaks »

Find Peak Pairs

Displacement Maps

2

Define Reference

Correct Scan Line Noise...

Base Vector 1

Length: |8.6 (8.6019)
Angle: |-135.2 (-135.2086)

Base Vector 2

Length: I 8.59 (8.58744)
Angle: | 134.8 (134.792)

Strain Map...

Repeat Project...
Project »

Image Group »

Analyze Peak Points
Analyze Equivalent Columns...

Distortion Analysis »

Histogram from Spreadsheet -
Show/Hide » [ OK ] [ Cancel ]
Add Color Marker
Create Vector Map...
Distortion Correction 4 Correct Distortion...
Help » Obtzinhi ign Info
Rectify Image...

The lengths and angles of current reference base vectors will be shown in the dialog. If the
values in the parentheses differ from the values expected from an ideal unit cell, you can
change the values accordingly.

By pressing OK, the distorted image is rectified using the local distortions at each point of the
image. To verify this, calculate the displacement maps from the rectified image. Then, we
observe that distortions have been corrected as shown below:

= V: Project4 D1h o |[@][=

e Y:Projectd DIv. o | 5] Bz AC: Project5D1h [ o |[@ [ R | | ¢ AF: ProjectsDIv. [ o |[@ |[= ]

% X: Project4 D2h W ziprojectaDy (o ][E ][] t AE: Projects D2h - [= (& ][52] || - AG: Project5 DoV o[-0 )

before correction after correction
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Appendix

Technical Note:
The results of the PPA package is the complete strain tensor defined as follows:

Strain values
ou ou Ou _ Ou y

X _ y _ X

e.= > e = LN — ) .
oo Yoy Yooy Y ox

Strain tensor:
E f— l % =+ a& 1 e aux au}' 1 aur au}’
i "EXX=79£ = 9£XV=* —+ —
2| dx; Ox ox Y o9y Y 2lay ox
Mean dilatation :
1(0u Ou,) .
A =—|—isT]1e A =i(g +& )
if xy T2\ % »y
2 ( ax,  ox, ]
Rotation (in radians and anti-clockwise positive):

o = L[ O 1w, ou,
Y20 ax,  ox. o2l ax o ay
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Some useful DM tricks

DM ROI tool:
: rﬁ. o Hint: to select a square area, hold down SHIFT.
- = To select powers of two, hold down SHIFT-ALT.

DM Zoom tool:

l 3 ( Q. ]T / 2 [] © || Hint: to demagnify, press ALT.

HREM Mouse tool

- Hint: to delete any spot, just
|} o € A [y &I Y = click on the mouse mark with
the SHIFT key down.

DM Image Display Command

-

wlPojeclex o G gl Projec e [o B[]

—

Hint: to change the color map of
any image, press the right mouse
button on it, select ImageDisplay,
and modify the options as desired.

For example, it is useful to set

ImageDisplay...

manually the color range of each
N map to be the same, so as to be able

Display Type
to compare each other.

42



HREM Research Inc.

Quick Reference Guide

The PPA Main Menu
PeakPairs |

PPA for DM Manual

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference
Correct Scan Line Noise...

Strain Map...

Repeat Project...
Project

Image Group

Analyze Peak Points

Distortion Analysis
Histogram from Spreadsheet
Show/Hide

Add Color Marker

Create Vector Map...

Distortion Correction

Help

Analyze Equivalent Columns...

/

Power Spectrum

Bragg Filter...

Adaptive Wiener Filter...

Low Pass Filter...

Define Motif

Refine Motif using high x-Corr Patches...

Discriminate Motifs...

Refine Motif Positions...

\

Discriminate Peaks...

Refine Peak Positions...

Remove Peaks

Add Peaks

7

Measure Distortion...
Show Motif Positions...
Show Arrows...

Show Color Map...
Update Front Image...

Correct Distortion...
Obtain Distortion Info
Rectify Image...

The commands in the PPA menu are described below.
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Command

Description

Fourier Space Noise

Filter (see sub menus)

Reduces noise using Fourier space filter.

Real Space Noise Filter

(see sub menus)

Reduces noise using Real Space Filter.

Set Reference Base
Vectors

Set the reference base vectors manually on a real-
space noise-filtered image or an image after Motif

(see Dialog) detection.
Note: Bragg filter sets the reference base vectors
automatically.
Motif Detection Detects repeating units (a group of peaks) using a
(see sub menus) Motif (small reference region).
Find Peaks Locates peaks of intensity in an image.

(see sub menus)

Note: Reference base vectors should be defined
beforehand.

Find Peak Pairs

Calculates pairs of peaks along two reference base
vectors automatically.

Displacement Maps

Generates horizontal and vertical displacements
along the two directions defined by the basis vectors

Define Reference

Changes the displacement values, so as to obtain a
uniform displacement in the chosen area.

Note: the area should be selected previously using
the ROI tool on any displacement image

Correct Scan Line
Noise...

Corrects imperfect scan-line control (scan-line noise)
of the STEM scanning system using a perfect area in
the image.

Note: the area should be selected previously using
the ROI tool on any displacement image.

Strain Map... Calculates strain maps (exx,eyy,exy and eyx) at any

(see Dialog) desired angle.

Repeat Project... Generates strain maps and other outputs for the front

(see Dialog) most image using the same conditions of a selected
project.

Project Menu to manage all the images in a particular

(see sub menus) project.

Image Group Menu to close or save groups of images within a

(see sub menus)

particular project.

Analyze Peak Points

Generates a spreadsheet of data (peak position,
peak intensities, strain values) for each peak

Analyze Equivalent

Columns... (see Dialog)

Analyzes equivalent column positions, as well as the
distances and angles between specified columns.
The independent column(s) will be specified using
the HREM Mouse tool.
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Distortion Analysis
(see sub menus)
(from v4.0)

PPA for DM Manual

Analyzes peak distances or angles of the peak-pairs,
or rotation angles of structural units (e.g. tetrahedron
or octahedron). The advanced analysis can be
performed using the DM script that simply calls the
functions provided by the PPA.

Histogram from
Spreadsheet

Calculates a different histogram for each selected
column in the spreadsheet

Show/Hide
(see sub menus)

Shows/hides a selected annotation on the image.

Add Color Marker

Adds a color bar and the low and high display
ranges. You can move the whole color marker or
change its size. Since the display ranges are text
annotations, you can move and edit them as you like.
The color marker can be placed outside of the image
display. You can rotate and flip using Edit commands.
(The ratio of the color bar is fixed.)

Create Vector Map...
(see Dialog)

Create a vector map from two component images
selected in the dialog.

Distortion Correction
(see sub menus)

Eliminates systematic distortions present in the
image based on the measurement of an ideal
distortion-free image.
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Power Spectrum ‘

Fourier Space Noise Filter SubMenu ’

Bragg Filter...

Component Description

Power Spectrum Calculates the Fourier transform of the front most
image, and displays the power at each frequency
(commonly called the Power Spectrum).

Bragg Filter... Calculates Bragg Filter using the spots selected in
(see Dialog) the Power Spectrum. The shape and size of the
mask can be defined by the user in the dialog.
Note: Spots should be selected beforehand in the
Power Spectrum using the Mouse Tool.

Note: The first and second spots defined the
Reference Base Vectors in real space.

Braqgq Filter Dialog
The components of the dialog are described below.
Dialog i Bragg Filter X
Project Name: |Project1
[ ]invert Peaks
Size:

Custom v W pixels ' Apply
Smoothing Width: |T
[JovalRatio: [0.5
Direction: W degree

OK Cancel

Component Description

Project Name Name given to the group of images and results

Invert Peaks If you want to analyze the hollows (dips), not peaks,
you should check this item.

Size Defines mask radius of hard cut-off (beyond which
values are set to zero).

Smoothing Width Specifies mask smoothing width in pixels

Oval Ratio Defines the shape of the oval, as major to minor axis
ratio

Direction Sets the prescribed masks angle, in degrees
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Real Space Noise Filter SubMenu

PPA for DM Manual

Adaptive Wiener Filter...

Low Pass Filter...

Component Description

Adaptive Wiener Filter... | Remove noise from the image using an adaptive
(see Dialog) Wiener filter based on a local variance.

Low Pass Filter... Calculates and applies a Low Pass filter to the image
(see Dialog)

Adaptive Wiener Filter Dialog

Dialog i Wiener Filter X
New Project: IPrOjT
[Jinvert Peaks
Adaptive Average: [1_ x2+1 pixels
Noise Estimation: [1_ x2+1 pixels
OK Cancel
Component Description
New Project Name given to the group of images and results
Invert Peaks If you want to analyze the hollows (dips), not peaks,
you should check this item.
Adaptive Average Window size [(2N+1)x(2N+1) pixels] to be used in the

calculation of the adaptive average

Noise Estimation

Window size [(2N+1)x(2N+1) pixels] to be used in the
calculation of the noise estimation

Low Pass Filter Dialog

Dia|°g E%j Low Pass Filter X

New Project: IProjT

[Jinvert Peaks
Radius(pixel): ‘T
OK Cancel

Component Description
New Project Name given to the group of images and results
Invert Peaks If you want to analyze the hollows (dips), not peaks,

you should check this item.

Radius(pixel)

The radius of the mask in pixels
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Set Reference Base Vectors Dialog

Dialog s Set Reference Base Vectors X

Project Name: | Projecti]
[Jinvert Peaks

Base Vector 1 (1->2) |Auto-divide v~ |1

Base Vector 2 (1->3) Auto-divide v |1

OK Cancel
Component Description
Project Name Name given to the group of images and results
Invert Peaks If you want to analyze the hollows (dips), not peaks,
you should check this item.
Base Vector 1 and 2 You can select Auto-divide or specify the number of
repeating units along two directions.
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Motif Detection SubMenu

PPA for DM Manual

Define Motif

Refine Motif using high x-Corr Patches...
Discriminate Motifs...

Refine Motif Positions...

Component

Description

Define Motif

Defines a Rectangle ROl as a Motif, and make it
rotatable.

Refine Motif using high
x-Corr Patches...
(see Dialog)

Calculates Cross-Correlation Histogram between the
selected reference region (motif) and the original
image, and refines the motif using high-scored
pathes.

Note: The left edge of the selection in the histogram
is used as a threshold to obtain the refined motif.

Discriminate Motifs

Calculates Cross-Correlation Histogram between the
refined motif and the original image, and refine again
the motif using high-scored pathes.

Note: The left edge of the selection in the histogram
is used as a threshold to find good maotifs.

Refine Motif Positions...
(see Dialog)

Refines the centers of good Motifs in the image.

Refine Motif using high x-Corr Patches Dialog

Dialog E% x-Corr Histogram X
Minimum Motif Distance: | 10.0
Show Original Motif
OK Cancel
Component Description

Minimum Motif Distance

Specifies a minimum distance between allowed
motifs. (This parameter is used in Find Motif
Centers...)

Show Original Motif

If checked, the original motif will be displayed.
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Refine Motif Positions Dialog

Dialog

E% Find Motif Centers X

Peak Threshold: |0.69

Show All Local Maxima
Show stacked motif

OK Cancel

Component

Description

Peak Threshold

Specifies a minimum for the intensity of allowed
Peaks.

Show All Local Maxima

If checked, the Motif centers rejected by the cross-
correlation threshold and/or the motif distance will be
shown in blue. (Namely, all the motif centers are
displayed in red or blue color.)

Show stacked motif

If checked, a stacked image from detected motifs will
be created.

Find Peaks SUbMenu Discriminate Peaks...

Refine Peak Positions...

Remove Peaks

Add Peaks

Component

Description

Discriminate Peaks

Calculates a histogram of peaks intensities, helping
the user to determine a precise value for Peak
Threshold.

Note: The left edge of the selection in the histogram
is used as a threshold to find good peaks.

Refine Peak Positions...

(see Dialog)

Refines peak positions by fitting a quadratic function
to peak intensity, and then calculates a histogram of
the peak heights of the quadratic function.

The peaks within a minimum distance will be merged.
Note: The left edge of the selection in the histogram
is used as a threshold to find good peaks.

Remove Peaks

Remove the peaks, which are selected by using
HREM Mouse.

Add Peaks

Refine and add the peaks, which are selected by
using HREM Mouse.
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Refine Peak Positions Dialog

Dialog

i Find Peaks X
Peak Threshold: |0.825
Typical Peak Width (FWHM): | 3.0

FWHM: Full-Width at Half-Maximum
Show All Local Maxima

OK Cancel

PPA for DM Manual

Component

Description

Peak Threshold

Specifies a minimum for the intensity of allowed

peaks

Typical Peak Width
(FWHM)

Specifies a typical peak width (FWHM in pixels). This
value will be used to merge the peaks.

Show All Local Maxima

Shows local maxima (of 8-neighbourhood) as blue

points.

Correct Scan Line Noise Dialog

Dialog i Correct Scan ... [
("] Correct All Line
[ OK ] [ Cancel ]
Component Description

Correct All Line

It modifies all scan lines, not only those within the

ROL.
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Strain Map Dialog

Dialog

PPA for DM Manual

iz Strain Map

Option

Angle of x-axis to horizontal: |0.0

Show the following images
[V Strain Matrix
Independent
@ Symmetric
[¥] Mean Dilatation
[V|Rotation Angle

("] overlay

[ OK ][ Cancel ]

L A

Option

Description

Angle of x-axis to
horizontal

Specifies the angle of the direction to be considered
as x-axis.

You can specify the orientation of the x-axis by
placing a Line ROl on the HREM image. In this case,
the angle of the Line ROl appears here automatically.
Note: If angle is set equal to 0, horizontal and vertical
directions are assumed to be x and y coordinate axis
respectively.

Strain Matrix

Specifies the images to be shown

Independent Images of du/dx, du/dy, dv/dx, dv/dy to be displayed
Symmetric Images of exx, gyy and &xy to be displayed.
Mean Dilatation Image of 8y, to be displayed (average of exxand gyy).
Rotation Angle Image of myxy to be displayed. Values in degrees and
anticlockwise positive.
Overlay Shows the strain at each atomic column, and

displayed as coloured dots over the original image
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Repeat Project Dialog
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Dialog

iz Repeat Project léj
New Project: |Proiect3

Project image to be repeated:

Project! Bragg Filtered Testimage LI

Select
{” Find Peaks
(" Find Peak Pairs
(" Displacement Maps
{¢ Strain Map

oK | Cancel |

L A

Component

Description

New Project

Defines the name of the new project.

Project image to be
repeated

Selects an open project to be used to generate strain
maps and other outputs for the front most HREM
image.

Note: If you want to use the project created during
the previous session, you may want to open it again.

Find Peaks

Repeats Find Peaks Operation.

Find Peak Pairs

Repeats Find Peak Pairs Operation.

Displacement Maps

Repeats Displacement Maps Operation.

Strain Map

Repeats Strain Map Operation.

Project Sub-Menu

Component Description

Hide Hides all the images in a project.

Show Shows all the images in a hidden project.

Save Saves all the images in a project (with save dialog
window).

Close Closes all the images in a project without saving.
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S
Image Group Sub-Menu C?::e

Component Description

Save Saves (with dialog) all images in a project of the
same type as the front most image (e.g. strain map
images).

Close Closes (without saving) all images of the same type
as the front most image.

Analyze Equivalent Columns Dialog

The user will have the option to decide the distances and/or angles to be
evaluated.

Distance Tab iz Analyze Equivalent Columns &J

Distance IAngIe I Option ]

[1 @2 [O]3

Distances from the checked point(s) to
other points will be evaluated.

[ OK ][ Cancel ]

The number of each check box corresponds to the assigned number to the mouse
click. All the distance(s) from the checked point to other points will be calculated.

Angle Tab t‘#: Analyze Equivalent Columns &J

Distance Andle | option |

M1 @2 03

Checked point(s) will be a vertex of angle(s)
subtended by two other points.

[ OK ][ Cancel ]

The number of each check box corresponds to the assigned number to the mouse
click. All possible angle(s) whose vertex corresponds to the checked point will be
calculated.
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Option Tab
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s

t.;._, Analyze Equivalent Columns

Distance | Angle Option I

(V| Position (Pos) number on the image
Column coordinate: @) Image origin (topeft)

Motif origin (top-eft)

[ OK ][ Cancel ]

L 4

Component

Description

Position (Pos) number
on the image

Display position number (Left column of the spread
sheet) on original image.

Column coordinate

(Motif Detection only)
You can select the origin of column positions in the
Motif.

Distortion AnalysisSub-Menu

Measure Distortion...

(from v4.0) Show Motif Positions...
Show Arrows...
Show Color Map...
Update Front Image...
Command Description

Measure Distortion...

At first, distortion values will be measured by running
the saved script. This command will open the dialog
to select the script.

NOTE: Alternatively, the distortions will be directly
measured by executing the script from the script
window.

Show Motif Positions...

Displays the evaluated motif positions.

Show Arrows... Displays the distortions measured by using
PPAPrepArrow in an arrow map.
Show Color Map... Displays the distortions measured by using

PPAPrepColorMap in a color map.

Update Front Image...

Updates the appearance of the arrow or color map
according to the modified appearance parameter(s).
The dialog for the arrow map or color map will be
opened according to the type of the front image.
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Measure Distortion Dialog

Dialog it MeasureDistortion X
Select Evalustion Script | ...tAnalysis¥TestMean.s
Qutput Spreadsheet Name:
| Quantumwire_s51
Find Peaks within | 5.0 pixels
oK Cancel
Component Description

Select Evaluation Script

Clicking on this button will open the file browser to
select the saved script.

NOTE: If you directly execute the script from the
script window, you will have a dialog without the file
selection capability.

Output Spreadsheet
Name

Specify an output spreadsheet name. The measured
distortion values will be saved as a spreadsheet.

Find Peaks within

Peaks will be searched in the specified area in pixel
from the corresponding points in the Motif.

Show Arrows Dialog

Dialog 5 Show Arrows X
Show Arrows for |testlarrow v
X,y components v X ’T
Show Motif Positions
OK Cancel
Component Description

Show Arrows for

Select the column in the spreadsheet corresponding
to the measured values to draw an arrow map.

Output value selector

Select the value(s) to draw an arrow.

Show Motif Positions

Shows the potions of the approximate motif centers.
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Show Color Map Dialog

Dialog

E%j Show Color Map X

Show Color Map for |testlcolormap v

Display Type
(® Polygon

(Ocirde  Radius |5 Pixel

Display Range (Percentile)
Low |0 % High | 100 %
Show Motif Positions

oK Cancel

Component

Description

Show Color map for

Select the column in the spreadsheet corresponding
to the measured values to draw a color map.

Display Type

Select the display type from Polygon and Circle. In
the case of the circle, the radius of the circle can be
specified.

Display Range

The display ranges will be specified in percentiles.

Show Motif Positions

If the display type is Circle, the potions of the
approximate motif centers can be drawn.

Show/Hide Sub-Menu Peaks

Peak Pairs

Motif
Command Description
Peaks Displays the circle at the peak positions on the

image.

Peak Pairs

Displays the peal-pair lines on the image.

Motif

Shows/hides Motif
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Create Vector Map Dialog
Dialog iz Create Vector Map [

Select two components

Horizontal: [O: Project2 D1h v ]
Vertical: [S: Project2 D1iv v ]
Arrow

Interval: |16| pixels
Length Scale: T

(Length = Scale * Interval)
Color: R [100 % G |20 % B |50 %

[ OK ] [ Cancel ]

Component Description

Horizontal Select an image corresponding to the horizontal
component.

Vertical Select an image corresponding to the vertical
component.

Interval Specifies an interval to draw arrows (in pixel)

Length Scale Specifies an arrow length. An actual length is Interval
* Scale (in pixel)

Color Specifies an arrow color in RGB.
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Distortion Correction Sub-Menu

PPA for DM Manual

Correct Distortion...

Obtain Distortion Info
Rectify Image...

Command

Description

Correct Distortion...

Rectifies any distorted image using the distortion
information obtained previously from an undistorted
sample using the “Obtain Distortion Info” command
below.

A dialog to select two images will be opened.

Obtain Distortion Info

Extracts distortion information from the Bragg image
of an undistorted crystal after calculating Peak Pairs.
This information will be used by the “Correct
Distortion” command above.

Rectify Image...
(see Dialog)

Rectifies an image of an undistorted crystal after
calculating Peak Pairs.

Default basis vector are automatically chosen from
the first and second selected Bragg spots. Basis
vectors can also be manually specified/modified by
the user.

Rectify Image Dialog

Dialog

e

i Rectify Image

Base Vector 1

Length: |8.6 (8.6019)
Angle: |-135.2 (-135.2086)

Base Vector 2

Length: |8.59 (8.58744)
Angle: | 134.8 (134.792)

[ ok

H Cancel ]

L 4

Component

Description

Length

Length of base vector considered for image
rectification, measured in pixels

Angle

Angle of base vector considered for image
rectification, measured in degrees
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